


 Click on the name of your tape drive to display the backup sets on the current tape.



If a device is highlighted on the left side of this window, you see a list of all backup sets contained at that location (for 
example: all backup sets on the tape currently in the highlighted tape drive).

Highlight the backup set from which you want to restore files.



If a device is highlighted on the left side of this window, you see a list of all backup sets contained at that location (for 
example: all backup sets on the tape currently in the highlighted tape drive).

Highlight the backup set from which you want to compare files.



Either accept the default name provided by Colorado Backup or type a name for the backup set you are about to 
create. The backup set contains the copy of the material you backed up.



Click this if you want to assign a password to the backup set.

A backup set is created when you back up folders (directories) or files. The backup set contains the copy of the 
material you backed up.



Type a password for this backup set. This password will be required before restoring any files from this backup set.

Up to 8 characters allowed



Retype (verify) the password you want to assign to this backup set.



Click the name of your tape drive.

Note: You can also backup to any drive that appears on this list.



Specifies the location you have selected as the destination for your backup copy.



Type the password that was assigned to this backup set. The password is required before restoring files from this 
backup set.



Click this to exclude the selected file types from the current backup, restore, or compare operation.

Tip: Your Exclude list will be erased when you close Colorado Backup.



Click this to remove the selected types of files from the Exclude list.

Tip: Your Exclude list will be erased when you close Colorado Backup.



Lists the types of files that will be excluded from the current backup, restore, or compare operation.

For example: You can exclude all *.exe files so that you no longer back them up or restore them.

Tip: Your Exclude list will be erased when you close Colorado Backup.



Click this if you want to exclude only files that were last modified within the range of dates shown.

For example: Exclude all files created before 1990.

Tip: Your Exclude list will be erased when you close Colorado Backup.



Specifies types of files (for example, .tmp) that you want to exclude from the current backup, restore, or compare 
operation.

To modify the Windows 95 registered file types list: 

· Double-click on the My Computer icon on your desktop. 

· Click the View menu, click Options. 

· Click the File Types tab, and follow the instructions for that dialog box.



Click this to select all file types in the list. 

This option is useful when you want to include only a few file types (such as all *.doc files) in a backup, restore, or 
compare operation: 

· Click Select All.

· Deselect the file types you want to include.

Note: Only those files that are not selected will be included in the operation.



Cancels all file-filtering options you have set.



Prompts you with a beep when Backup is ready for the next step of an operation.



Replaces the existing “Last operation’s results” log file with a new one as the backup operation takes place.

If this option is turned off, the new information is added to the end of the existing log file.

Note To view the “Last operation’s results” log, click on Start, Programs, Colorado Backup for Windows 95, Last 
operation’s results.



Closes Backup after the current operation is finished.



 Backs up all the files you selected, including files that haven't changed since the last backup. 

(Contrast with modified backup, which backs up only the files that have changed or have been created in selected 
folders since the last time you backed up the selected files.)



Backs up only those files in the selected group of files that have changed (or files that have been created in selected 
folders) since the last time you backed them up. 

(Contrast with full backup, which makes backup copies of all the files you select, including files that haven't changed 
since the last backup.)



Specifies that Backup should automatically compare the backed up copies with the original files to be sure they were 
copied accurately.



Specifies that you want to use the Backup data-compression feature when you are backing up to a tape drive. This 
reduces the space that backed up data occupies on the tape.

Note: Your files are automatically returned to their original condition when you restore them from the tape.



Formats the tape in the tape drive automatically before files are copied to it. 

This will happen only for tapes that have never been formatted before.



Erases the tape in the tape drive automatically before files are copied to it. 

If this option is turned off, the backup set will be added to the current tape. If your tape is full, Colorado Backup 
prompts you to insert another tape, and then continues with the operation.



Closes Backup after it has finished restoring your files.



Restores the files you requested to their original location (the location they were in when the backup was made).



Restores your files to a new location (for example, from C: to D: or from C:\CURRENT\*.* to C:\OLD\*.*) and 
maintains all folders (directories) and files by their original names.



Restores files from multiple folders (directories) and places ALL those files into the SAME FOLDER (that you specify).



Specifies that Backup should automatically compare the backed up copies with the restored files to be sure the files 
were restored accurately.



Specifies that Backup should NOT REPLACE ANY files on the destination drive with the backed up copies of those 
files. 

This will prevent your overwriting any file already on the destination drive.



Specifies that Backup should replace files on the destination drive only if they are older than the backed up copies of 
those files. 

This will prevent your overwriting a newer version of a file with an older version of the same file.



Specifies that Backup should ALWAYS REPLACE files on the destination drive with the copies of those files found in 
your backup set.



Specifies that Backup should ask permission, before overwriting any file on your destination drive.



Closes Backup when it has finished comparing the files you requested.



Specifies that the files on your hard drive are in the same location that they were in when your backup copy was 
made.



Specifies that the files on your hard drive have been moved to a different location since your backup copy was made, 
but the folders (directories) still have the same names.

For example: you moved folders from C: to D: since the backup copy was made.

You will be prompted to indicate the new location before comparing.



Specifies that you have moved your files from a variety of folders (directories) into one folder on your hard drive, 
since the backup copy was made.

You will be prompted to indicate the new folder’s name before comparing.



Closes Backup after the file set has finished backing up:

· after double-clicking on a file-set file name in the Windows\Backup\ directory (in Explorer) 

· after dragging and dropping a file-set icon onto the Hpbackup icon (in Explorer) 

· at the time the backup is scheduled to run (in Colorado Scheduler)



 Note: do not use this feature if you plan to run your backup at a scheduled time (in Colorado Scheduler).

Requires you to click Confirm before the backup will begin:

· after double-clicking on a file-set file name in the Windows\Backup\ directory (in Explorer) 

· after dragging and dropping a file-set icon onto the Hpbackup icon (in Explorer) 

· at the time the backup is scheduled to run (in Colorado Scheduler)



 Specifies that the Backup window should be minimized during backup:

· after double-clicking on a file-set file name in the Windows\Backup\ directory (in Explorer) 

· after dragging and dropping a file-set icon onto the Hpbackup icon (in Explorer) 

· at the time the backup is scheduled to run (in Colorado Scheduler)



 This backup program works only with the following Hewlett-Packard / Colorado Memory Systems tape drives.

If your tape drive does not appear in the list below, contact your tape drive manufacturer for information about backup
software that you can use with Windows 95.

· Jumbo or Trakker 120

· Jumbo or Trakker 250

· Jumbo or Trakker 350

· Jumbo or Trakker 700

· Jumbo 1400

· Colorado T1000 or T1000e

· PowerDAT

· PowerTape

· SureStore



Help is available for each item in this group. 

Simply right-click on any individual item (not in the grey space around it).



Type a name for your tape (up to 44 characters).



To display drive or folder contents, click the plus signs  or double-click drive icons or folder icons

To select items, click the boxes:
 = no files selected

 = all files selected

 = some files selected



This is the contents of the item highlighted on the left side of this window.

To select items, click the boxes:
 = no files selected

 = all files selected

 = some files selected

 = this file selected 



Use Full System Backup to copy all files on all local hard drives, plus the Windows 95 registry. 

Important: Using the Full System Backup file set is the only way to back up your Windows 95 registry. The registry is 
the structured database that keeps track of all configuration settings for hardware and software on your system. 



To view or modify your current Windows 95 registered file type list:

· double-click on the My Computer icon on your desktop

· click the View menu

· click Options 

· click the File Types tab



To prepare the tape for storing data according to your tape drive's specifications.

This process eliminates any existing data on the tape (the data cannot be recovered with unerase).



To delete all volumes from a tape by modifying the tape's directory information.



To delete all volumes from a tape by overwriting the data with a repetitive pattern from beginning to end so that the 
original data can never be recovered.



To restore the tape's directory information. This makes erased backup sets and their files accessible again. 

Unerase only works: 

· after a tape is erased with the Quick erase command and 

· before other information is written to the tape.



To wind a tape from end-to-end, applying even tension throughout the length of the tape. With even tension, the tape 
drive can read information from the tape more accurately.



To change the name of your tape.



.Starts the operation.



 Exits this dialog box without starting the operation.



To back up your entire system (Colorado Backup open)

Having a recent Full System Backup of your system on tape is critical in case of disaster:

1 Click the Backup tab.

2 On the File menu, click Open File Set.

3 Click Full System Backup (this file set was created the first time you opened this program).

4 Click Open. All files on all local drives are selected, as well as your system registry.

5 Click the Next>> button, and click the name of your tape drive.

6 Click the Next>> button, and select your options for this backup (name, verify, data compression, erase tape).

If you want to assign a password, click Password Protect.

7 Click the Finish>> button.

{button ,AL("A_BACKUP_SELECTED_FOLDFILES;A_BACKUP_FULLSYS_CLOSED;")} Related Topics



To back up your entire system (Colorado Backup closed)

Having a recent Full System Backup of your system on tape is critical in case of disaster:

There are four ways to start one:

· simply close Colorado Backup and double-click on the Full System Backup icon located on your desktop.

· or double-click on the Full System Backup file set file name in the Windows\Backup\ directory (in Explorer) 
· or drag and drop the icon of the Full System Backup file-set file onto the Hpbackup icon (in Explorer). 

· or schedule Full System Backup file set to run in Colorado Scheduler. 

{button ,AL("A_BACKUP_SELECTED_FOLDFILES;A_BACKUP_FULLSYS;A_SCHEDULE_FULL_SYSTEM_BACKU
P;")} Related Topics



To back up selected folders and files

1 Click the Backup tab.

2 To display drive or folder contents, click the plus signs  or double-click drive icons or folder icons.

To select items, click the boxes:
 = no files selected

 = all files selected

 = some files selected

 = this file selected 
3 Click the Next>> button, and click the name of your tape drive.

4 Click the Next>> button, and select your options for this backup (name, verify, data compression, erase tape).

If you want to assign a password, click Password Protect.

5  Click the Finish>> button.

{button ,AL("A_BACKUP_OPEN_FILESET;A_BACKUP_SAVE_FILESET;A_BACKUP_FILTER_DATETYPE;A_BACK
UP_FILTER_DATATYPE")} Related Topics



To restore your entire system

Place the tape containing your most recent Full System Backup into the tape drive.

1 Click the Restore tab.

2 In the left window, click the name of your tape drive. 

3 In the right window, click the name of your most recent Full System Backup backup set.

4 Click the Next>> button. 

In the right window, click the check box next to each hard drive letter.
 = no files selected

 = all files selected
5 Click the Next>> button, and select your options for this restore (verify, overwrite).

6 Click the Finish>> button.

7 After your files are restored, restart your computer.

Note: To return your computer to its most recent state, restore any other backups (that you have made since this 
Full System Backup) in the order in which they were made.

Tip
If you use the full-system backup set to restore individual files, you may get a message that the registry was not 
restored correctly. If the Windows directory was not restored, you can ignore this message.

{button ,AL("A_BACKUP_RESTORE_FOLDFILE;A_BACKUP_RESTORE_NEW_LOCATION")} Related Topics



To restore folders and files (original location)

Place the tape containing your backed up files into the tape drive.

1 Click the Restore tab.

2 Click the name of your tape drive.

3 In the right side of the window, click the backup set you want.

4 Click the Next>> button. 

· To display drive or folder contents, click the plus signs  or double-click drive icons or folder icons.

· To select items, click the boxes:

 = no files selected

 = all files selected

 = some files selected

 = this file selected 
5 Click the Next>> button, and select your options for this restore (verify, overwrite).

6 Click the Finish>> button.

{button ,AL("A_RESTORE_FULLSYS;A_BACKUP_RESTORE_NEW_LOCATION;")} Related Topics



To restore folders and files (new location)

Place the tape containing your backed up files into the tape drive.

1 Click the Restore tab.

2 Click the name of your tape drive.

3 In the right side of the window, click the backup set you want.

4 On the Settings menu, click Options. 

5 Click the Restore tab, and click on the “Restore backed up files to” option of your choice.

Right-click on any individual option’s name for more information.

Click on OK to return to the main window. 

6 Click the Next>> button. 

· To display drive or folder contents, click the plus signs  or double-click drive icons or folder icons.

· To select items, click the boxes:

 = no files selected

 = all files selected

 = some files selected

 = this file selected 
7 Click the Next>> button, and select your options for this restore (verify, overwrite).

8 Click the Finish>> button.

9 Select the new location for your files, and click on OK.

{button ,AL("A_RESTORE_FULLSYS;A_BACKUP_RESTORE_FOLDFILE;")} Related Topics



To compare file contents with a backup set (verify)

Place the tape containing your backed up files into the tape drive.

1 Click the Compare tab.

2 In the left side of the window, click the name of your tape drive.

3 In the right side of the window, click the backup set you want to compare.

4 Click the Next>> button. 

· To display drive or folder contents, click the plus signs  or double-click drive icons or folder icons.

· To select items, click the boxes:

 = no files selected

 = all files selected

 = some files selected

 = this file selected 
5 Click the Next>> button, and indicate the current location of the original files.

6 Click the Finish>> button.

If you indicated an alternate location, select that location, and press OK.



To back up a file set (Colorado Backup open)

1 On the File menu, click Open File Set.

2 Click the name of the file set you want to use, click Open. The files contained in your file set are now selected.

 = no files selected

 = all files selected

 = some files selected

 = this file selected 
3 Click the Next>> button, click the name of your tape drive.
4 Click the Next>> button, and select your options for this backup (name, verify, data compression, erase 
tape).

If you want to assign a password, click Password Protect.

5 Click the Finish>> button.

Important
To back up your entire system, use the Full System Backup file set.

{button ,AL("A_BACKUP_FULLSYS;A_BACKUP_FULLSYS_CLOSED;A_BACKUP_SAVE_FILESET;A_BACKUP_BA
CKUP_DIFF_REG;A_BACKUP_BACKUP_DIFF_REG_CLOSED;A_BACKUP_OPEN_FILESET_CLOSED ")} 
Related Topics



To back up a file set (Colorado Backup closed)

There are three ways to start a backup using your file set:

· double-click on your file-set file name in the Windows\Backup\ directory (in Explorer).

· or drag and drop the icon of your file-set file onto the Hpbackup icon (in Explorer). 

· or schedule your file-set file to run in Colorado Scheduler.
Important
To back up your entire system, use the Full System Backup file set.

{button ,AL("A_BACKUP_FULLSYS;A_BACKUP_FULLSYS_CLOSED;A_BACKUP_SAVE_FILESET;A_BACKUP_BA
CKUP_DIFF_REG;A_BACKUP_BACKUP_DIFF_REG_CLOSED;A_BACKUP_OPEN_FILESET ")} Related Topics



To exclude files of a specific type or date

1 On the Settings menu, click File Filtering.

2 Click the options you want.

Right-click on any individual option’s name for more information.

Important: The file types that you specify will no longer be displayed in the file list window and no longer be included 
in your backup operations.



To specify settings for an operation

1 On the Settings menu, click Options.

2 Click the tab for the settings you want to change, and then click the options you want.

Right-click on any individual option’s name for more information.

Examples of options:

· data compression during a backup

· comparing files after a backup

· overwriting files during a restore

· overwriting the “Last operation’s results” log file (where error messages are stored)

Note To view the “Last operation’s results” log, click on Start, Programs, Colorado Backup for Windows 95, Last 
operation’s results.

{button ,AL("A_BACKUP_OPTIONS_DRAGDROP;A_BACKUP_BACKUP_DIFFERENTIAL;A_BACKUP_FILTER_DA
TETYPE")} Related Topics



To change drag and drop options

1 Click the Settings menu, click Drag and Drop.

2 Click on any options to select them.

Right-click on any individual option’s name for more information.



To format a tape

1 Insert the tape into the tape drive.

Note: If you have more than one tape drive attached to your system:
· click on the Restore tab 

(to view the list of tape drives)
· highlight the tape drive you wish to use

2 On the Tools menu, click Format Tape. 

3 Type a name for the tape when prompted.

Tips
· Formatting a tape can take up to several hours, depending on the size of the tape.

· If formatting fails or is progressing very slowly, there may be a conflict between your video display driver and floppy
disk controller. It may be possible to avoid this by starting the format operation and then starting a full-screen MS-
DOS window. 

{button ,AL("A_BACKUP_TAPEDRIVE_LIST;WHICH_TAPES ")} Related Topics



To rename a backup tape

1 Insert the tape into the tape drive.

Note: If you have more than one tape drive attached to your system:
· click on the Restore tab 

(to view the list of tape drives)
· highlight the tape drive you wish to use

2 On the Tools menu, click Rename Tape.

3 Enter the new name when prompted to do so.

Tip
Rename is not available when using PowerTape, PowerDAT, and SureStore tape drives.



To quick erase a backup tape

1 Insert the tape into the tape drive.

Note: If you have more than one tape drive attached to your system:
· click on the Restore tab 

(to view the list of tape drives)
· highlight the tape drive you wish to use

2 On the Tools menu, click Quick Erase Tape.

Tips
· You can erase only the entire tape, not part of the tape.

· With some tape drives, you can unerase a tape if you erased it using Quick Erase, but only if you have not yet 
written any other information to that tape.



To secure erase a backup tape

1 Insert the tape into the tape drive.

Note: If you have more than one tape drive attached to your system:
· click on the Restore tab 

(to view the list of tape drives)
· highlight the tape drive you wish to use

2 On the Tools menu, click Secure Erase Tape.

Tips
· Secure erase can take up to several hours, depending on the size of the tape.

· You can erase only the entire tape, not part of the tape.

· You cannot unerase a tape after using Secure Erase.



To unerase a backup tape

1 Insert the tape into the tape drive.

Note: If you have more than one tape drive attached to your system:
· click on the Restore tab 

(to view the list of tape drives)
· highlight the tape drive you wish to use

2 On the Tools menu, click Unerase Tape.

Tips
· You can unerase a tape only if you erased it using Quick Erase and have not yet written any other information to 

that tape.

· Unerase is not available when using PowerTape, PowerDAT, and SureStore tape drives.



To retension a backup tape

1 Insert the tape into the tape drive.

Note: If you have more than one tape drive attached to your system:
· click on the Restore tab 

(to view the list of tape drives)
· highlight the tape drive you wish to use

2 On the Tools menu, click Retension Tape.

Tips
· This ensures an even tension from end to end on your tape and may eliminate tape read errors.

· Retension is not available when using PowerDAT tape drives.



Tape drives that are compatible with this backup program

Backup works only with the following Hewlett-Packard / Colorado Memory Systems tape drives:

· Jumbo or Trakker 120

· Jumbo or Trakker 250

· Jumbo or Trakker 350

· Jumbo or Trakker 700

· Jumbo 1400

· Colorado T1000 or T1000e

· PowerDAT

· PowerTape

· SureStore

Drives may be connected to:

· a parallel port

· a secondary floppy disk controller 

· an accelerator card

· a SCSI adapter board



To perform modified backups of your entire system (Colorado Backup open)

Any files that have been created or changed on all of your hard drives since the last backup will be automatically 
selected. 

The Modified Backup file set uses the Archive Attribute bit to determine which files to include. The Archive Attribute 
setting is updated after each backup.

1 Click the Backup tab.

2 On the File menu, click Open File Set.

3 Click Modified Backup (this file set file is created for you by Colorado Backup).

4 Click Open. All files created or modified on all of your hard drives since your last backup are selected.

5 Click the Next>> button, and click the name of your tape drive

6 Click the Next>> button, and select your options for this backup (name, verify, data compression, erase tape).

If you want to assign a password, click Password Protect.

7 Click the Finish>> button.

{button ,AL("A_BACKUP_BACKUP_DIFFERENTIAL;A_BACKUP_BACKUP_DIFF_REG_CLOSED;")} Related Topics



To perform modified backups of your entire system (Colorado Backup closed)

Any files that have been created or changed on all of your hard drives since the last backup will be automatically 
selected. 

The Modified Backup file set uses the Archive Attribute bit to determine which files to include. The Archive Attribute 
setting is updated after each backup.

There are three ways to start:

· double-click on the Modified Backup file-set file name in the Windows\Backup\ directory (in Explorer).

· or drag and drop the icon of the Modified Backup file-set file onto the Hpbackup icon (in Explorer). 

· or schedule Modified Backup file set to run in Colorado Scheduler.

{button ,AL("A_BACKUP_BACKUP_DIFFERENTIAL;A_BACKUP_BACKUP_DIFF_REG;A_SCHEDULE_MODIFIED_
BACKUP;")} Related Topics



To back up only changed files within a file set

1 Click the Backup tab.

2 On the File menu, click Open File Set.

3 Select the name of your predefined file set, click Open. (All files listed in your file set are automatically selected.) 

4 On the Settings menu, click Options. 

5 On the Backup tab, click Modified, and then click OK. (modified backup uses the Archive Attribute to determine 
which files to include.)

Warning: Every backup from now on will be a modified-files-only backup until you change this setting back to Full.
6 Click the Next>> button, and select the name of your tape drive.

7 Click the Next>> button, and select your options for this backup (name, verify, data compression, erase tape).

If you want to assign a password, click Password Protect.

8 Click the Finish>> button. 

The Archive Attribute setting is updated after each backup.

Tips
· Remember that only files listed in your file set can be included. Files that have been renamed or created since your

file set was defined, will not be included.

· Schedule your backup to run on a regular cycle, click Related Topics below.

· To restore all files in your file set, you will need the most recent “Full“ backup using this file set, plus each 
“Modified” backup of this file set since that time.

{button ,AL("A_BACKUP_OPEN_FILESET;A_SCHEDULE_YOUR_OWN_BACKUP;A_BACKUP_BACKUP_DIFF_RE
G;A_BACKUP_SAVE_FILESET")} Related Topics



To create a file set (automating backup)

1 Follow the directions for doing a backup of selected folders and files.

2 Just before you click the Finish>> button to start the backup: 

· click on the File menu

· click Save As

· type a name for your file set.

Click here for naming rules.

File sets are saved to the Windows\Backup\ directory and have the following icon:

3 To use this file set in the future: 

· In Explorer, you can start this backup by simply double-clicking on the file-set’s name. 

· In Colorado Scheduler, you can schedule it to start at a specific time.

To use this file set now, click the Finish>> button.

{button ,AL("A_BACKUP_OPEN_FILESET;A_SCHEDULE_YOUR_OWN_BACKUP")} Related Topics



Scheduling your own custom backup

1 Create your own file set. 

2 Open the Colorado Scheduler program by double-clicking on the Colorado Scheduler icon in the Windows 95 
taskbar:

Note: If the icon is not there, start Colorado Scheduler by clicking on Start, Programs, Colorado Backup for 
Windows 95, Scheduler.

3 Click the What’s Scheduled tab.

4 Click the Add Schedule button.

5 Set up a schedule for your file set (*.Fst file). It is stored in the Windows\Backup\ directory and has the following 
icon:

{button ,AL("A_BACKUP_SAVE_FILESET")} Related Topics



Scheduling full system backups

1 Open the Colorado Scheduler program by double-clicking on the Colorado Scheduler icon in the Windows 95 
taskbar:

Note: If the icon is not there, start Colorado Scheduler by clicking on Start, Programs, Colorado Backup for 
Windows 95, Scheduler.

2 Follow the directions for turning on Automated Daily Backups.

Tip
You can modify this schedule using Colorado Scheduler: 

· click on the What’s Scheduled tab

· click on Full System Backup

· click the Modify button and make your changes



Scheduling modified backups of all local hard drives

Any files that have been created or changed on all of your hard drives since the last backup will be automatically 
selected. 

The Modified Backup file set uses the Archive Attribute bit to determine which files to include. The Archive Attribute 
setting is updated after each backup.

1 Open the Colorado Scheduler program by double-clicking on the Colorado Scheduler icon in the Windows 95 
taskbar:

Note: If the icon is not there, start Colorado Scheduler by clicking on Start, Programs, Colorado Backup for 
Windows 95, Scheduler.

2 Click the What’s Scheduled tab.

3 Highlight the Modified Backup file set.

4 Click the Add Schedule button and follow the directions for setting up a schedule time.

Colorado Backup updates the Archive Attribute setting after each backup.



 A file set is a file that specifies a group of folders and/or files that you want to back up plus all backup options that 
you selected. 

File sets are stored in the Windows\Backup\ directory and have the following icon:

In Explorer, you can start this backup by simply double-clicking on the file-set’s name. 
In Colorado Scheduler, you can schedule it to start at a specific time.



 A backup set is created when you back up folders or files. The backup set contains the copy of the material you 
backed up.



Click Help Topics to return to the list of topics. 



File set naming rules

Use up to 255 of the following characters:

· alphanumeric

· spaces

· $ % ` - _ @ ~ ! ( ) { } # & + , ; = [ ]

· Not allowed: \ / : * ? " < > | 



Tapes: How do they work?

A music cassette tape has songs recorded one after another. To listen to a particular song, you must fast forward or 
rewind. Your backup tape works in the same way.

Each time you backup files, a backup set (similar to one song) is recorded on your tape. Backup sets can be 
appended to tape (placed on the tape one after another). If the backup set is too large to fit on your tape, Colorado 
Backup will prompt you to insert another tape and will automatically continue the backup on the next tape. 

Unlike a music tape, your backup tape contains a directory so that you can quickly locate:

· each backup set

· any file within each backup set

Keep in mind that you cannot erase specific pieces of information from a tape. You must erase the whole.

{button ,AL("WHICH_TAPES")} Related Topics



Which tapes work in my tape drive?

Click on the name of your tape drive:

· Jumbo 120 and Trakker 120

· Jumbo 250, Trakker 250, and Colorado JS-20

· Jumbo 350 and Trakker 350

· Jumbo 700 and Trakker 700

· Jumbo 1400

· HP Colorado T1000 and T1000e

· PowerTape 1 gigabyte

· PowerTape 2 gigabyte

· PowerTape 4 gigabyte

· PowerDAT 4 gigabyte (PD-60)

{button ,AL("TAPES_HOW_THEY_WORK")} Related Topics



Jumbo 120 and Trakker 120 
compatible tapes (QIC-40 tapes)

The following types of tape work with your Jumbo 120 or Trakker 120 tape drive. Your tape must be QIC-40 formatted
before it is ready to use.

Tapes can be purchased preformatted (make sure they have QIC-40 format) or unformatted (use Colorado Backup 
and your tape drive to format the tape). 

Ask for HP Colorado brand tapes (preformatted and certified for use with your tape drive):

· HP Colorado DT-120 (307.5 foot tape) holds up to 60 MB (*approximately 120 MB compressed)

Look for any brand of:

· DC-2120:    307.5 foot tape, holds up to 60 MB (*approximately 120 MB compressed)

· DC-2000:    205 foot tape, holds up to 40 MB (*approximately 80 MB compressed)

*Compression capacity will vary; average is 2:1.



Jumbo 250, Trakker 250, and Colorado JS-20 compatible tapes (QIC-80 tapes)

The following types of tape work with your Jumbo 250, Trakker 250, or JS-20 tape drive. Your tape must be QIC-80 
formatted before it is ready to use.

Tapes can be purchased preformatted (make sure they have QIC-80 format) or unformatted (use Colorado Backup 
and your tape drive to format the tape). 

Ask for HP Colorado brand tapes (preformatted and certified for use with your tape drive):

· HP Colorado DT-250 (307.5 foot tape), holds up to 125 MB (*approximately 250 MB compressed)

Look for any brand of:

· DC-2120:    307.5 foot tape, holds up to 125 MB (*approximately 250 MB compressed)

· DC-2080:    205 foot tape, holds up to 84 MB (*approximately 166 MB compressed)

NOTE: These tape drives can read from, but not write to tapes formatted for the Jumbo 120 and Trakker 120 (QIC-40
formatted tapes).

TIP: You can bulk-erase the QIC-40 formatted tapes (using an electronic demagnitizer), and then reformat them to 
become QIC-80 tapes. 

*Compression capacity will vary; average is 2:1.



Jumbo 350 and Trakker 350 
compatible tapes (QIC-80 tapes)

The following types of tape work with your Jumbo 350 or Trakker 350 tape drive. Your tape must be QIC-80 formatted
before it is ready to use.

Tapes can be purchased preformatted (make sure they have QIC-80 format) or unformatted (use Colorado Backup 
and your tape drive to format the tape). 

Ask for HP Colorado brand tapes (preformatted and certified for use with your tape drive):

· HP Colorado DT-350 (425 foot tape), holds up to 170 MB (*approximately 340 MB compressed)

· HP Colorado DT-250 (307.5 foot tape), holds up to 125 MB (*approximately 250 MB compressed)

Look for any brand of:

· DC-2120XL:    425 foot tape, holds up to 170 MB (*approximately 340 MB compressed)

· DC-2120:    307.5 foot tape, holds up to 125 MB (*approximately 250 MB compressed)

· DC-2080:    205 foot tape, holds up to 84 MB (*approximately 166 MB compressed)

· 1000EX (with QIC 80 format):    1,000 foot tape, holds up to 400 MB (*approximately 800 MB compressed)

NOTE: These tape drives can read from, but not write to tapes formatted for the Jumbo 120 and Trakker 120 (QIC-40
formatted tapes).

TIP: You can bulk-erase the QIC-40 formatted tapes (using an electronic demagnitizer), and then reformat them to 
become QIC-80 tapes. 

*Compression capacity will vary; average is 2:1.



Jumbo 700 and Trakker 700 
compatible tapes (QIC-3010 tapes)

The following types of tape work with your Jumbo 700 or Trakker 700 tape drive. Your tape must be QIC-3010 
formatted before it is ready to use.

Tapes can be purchased preformatted (make sure they have QIC-3010 format) or unformatted (use Colorado Backup
and your tape drive to format the tape). 

Ask for HP Colorado brand tapes (preformatted and certified for use with your tape drive):

· HP Colorado DT-740 (400 foot tape), holds up to 340 MB (*approximately 680 MB compressed)

Look for any brand of:

· MC-3000XL:    400 foot tape, holds up to 340 MB (*approximately 680 MB compressed)

· MC-3000:    300 foot tape, holds up to 250 MB (*approximately 500 MB compressed)

NOTE: These tape drives can read from, but not write to:

· Tapes listed for the Jumbo 120 and Trakker 120 (QIC-40 tapes)

· Tapes listed for the Jumbo 250, Trakker 250, and Colorado JS-20 (QIC-80 tapes)

· Tapes listed for the Jumbo 350 and Trakker 350 (QIC-80 tapes)

· None of the tapes in this note can be reformatted to QIC-3010.

*Compression capacity will vary; average is 2:1.



Jumbo 1400
compatible tapes (QIC-3020 tapes)

The following types of tape work with your Jumbo 1400 tape drive. Your tape must be QIC-3020 formatted before it is 
ready to use.

Tapes can be purchased preformatted (make sure they have QIC-3020 format) or unformatted (use Colorado Backup
and your tape drive to format the tape). 

Ask for HP Colorado brand tapes (preformatted and certified for use with your tape drive):

· HP Colorado DT-1400 (400 foot tape), holds up to 700 MB (*approximately 1.4 GB compressed)

Look for any brand of:

· MC-3000XL:    400 foot tape, holds up to 700 MB (*approximately 1.4 GB compressed)

· MC-3000:    300 foot tape, holds up to 500 MB (*approximately 1 GB compressed)

· 1000EX (with QIC 3020 format):    1,000 foot tape, holds up to 1.6 GB (*approximately 3.2 GB compressed)

NOTE: This tape drive can read from, but not write to:

· Tapes listed for the Jumbo 120 and Trakker 120 (QIC-40 tapes)

· Tapes listed for the Jumbo 250, Trakker 250, and Colorado JS-20 (QIC-80 tapes)

· Tapes listed for the Jumbo 350 and Trakker 350 (QIC-80 tapes)

· Tapes formatted for the Jumbo 700 and Trakker 700 (QIC-3010 tapes)

TIP: You can bulk-erase the QIC-3010 formatted tapes (using an electronic demagnitizer), and then reformat them to 
become QIC-3020 tapes. 

*Compression capacity will vary; average is 2:1.



HP Colorado T1000 and T1000e
compatible tapes (QIC-80 tapes)

The following types of tape work with your T1000 or T1000e tape drive. Your tape must be QIC-80 formatted before it 
is ready to use.

Tapes can be purchased preformatted (make sure they have QIC-80 format) or unformatted (use Colorado Backup 
and your tape drive to format the tape). 

Ask for HP Colorado brand tapes (preformatted and certified for use with your tape drive):

· HP Colorado DT-T1000 (750 foot tape), holds up to 400 MB (*approximately 800 MB compressed)

· HP Colorado DT-350 (425 foot tape), holds up to 170 MB (*approximately 340 MB compressed)

· HP Colorado DT-250 (307.5 foot tape), holds up to 125 MB (*approximately 250 MB compressed)

Look for any brand of:

· Travan TR-1:    750 foot tape, holds up to 400 MB (*approximately 800 MB compressed)

· QIC-wide:    400 foot tape, holds up to 210 MB (*approximately 420 MB compressed)

· DC-2120XL:    425 foot XL tape, holds up to 170 MB (*approximately 340 MB compressed)

· DC-2120:    307.5 foot tape, holds up to 125 MB (*approximately 250 MB compressed)

· DC-2080:    205 foot tape, holds up to 84 MB (*approximately 166 MB compressed)

· 1000EX (with QIC 80 format):    1,000 foot tape, holds up to 400 MB (*approximately 800 MB compressed)

· 1000EX (with QIC wide 80 format):    1,000 foot tape, holds up to 500 MB (*approximately 1 GB compressed)

NOTE: These tape drives can read from, but not write to tapes formatted for the Jumbo 120 and Trakker 120 (QIC-40
tapes).

TIP: You can bulk-erase the QIC-40 formatted tapes (using an electronic demagnitizer), and then reformat them to 
become QIC-80 tapes. 

*Compression capacity will vary; average is 2:1.



PowerTape 1 GB 
compatible tapes (QIC-525 tapes)

Ask for HP Colorado brand tapes (certified for use with your tape drive):

· HP Colorado DT-1100 (1020 foot tape), holds up to 500 MB (*approximately 1 GB compressed) 

Look for any brand of:

· DC-6525:    1020 foot tape, holds up to 500 MB (*approximately 1 GB compressed)

*Compression capacity will vary; average is 2:1.



PowerTape 2 GB 
compatible tapes (QIC-1000 tapes)

Ask for HP Colorado brand tapes (certified for use with your tape drive):

· HP Colorado DT-2400 (950 foot tape), holds up to 1.2 GB (*approximately 2.4 GB compressed)

Look for any brand of:

· Magnus 1.2 or DC9120:    950 foot tape, holds up to 1.2 GB (*approximately 2.4 GB compressed)

· Magnus 1.0:    760 foot tape, holds up to 1 GB (*approximately 2 GB compressed)

NOTE: This tape drive can read from, but not write to the DC-6525 tapes used by the PowerTape 1GB tape drive.

TIP: You can bulk-erase the DC-6525 tapes used by PowerTape 1GB tape drive (using an electronic demagnitizer), 
and then reformat them for read/write capabilities with the above drive. The capacity of the tape does not increase. 

*Compression capacity will vary; average is 2:1.



PowerTape 4 GB 
compatible tapes (QIC-2000 tapes)

Ask for HP Colorado brand tapes (certified for use with your tape drive):

· HP Colorado DT-4000 (950 foot tape), holds up to 2 GB (*approximately 4 GB compressed)

Look for any brand of:

· Magnus 2 GB or DC9200:    950 foot tape, holds up to 2 GB (*approximately 4 GB compressed)

NOTE: This tape drive can read from, but not write to:

· tapes used by the PowerTape 1 GB 

· tapes used by the PowerTape 2GB tape drives

TIP: You can bulk-erase the tapes referenced in the note above (using an electronic demagnitizer), and then reformat
them for read/write capabilities with the PowerTape 4GB tape drive. The capacity of those tapes will not increase. 

*Compression capacity will vary; average is 2:1.



PowerDAT 4 GB (PD-60) 
compatible tapes (DDS/MRS tapes)

Any "Digital Data Storage/ Media Recognition System (DDS/MRS)" tape.
NOTE: Do not use "audio quality" tapes.
Ask for HP brand tapes (certified for use with your tape drive):
· HP 92283B (90 meter tape), holds up to 2 GB (*approximately 4 GB compressed)

· HP 92283A (60 meter tape), holds up to 1.3 GB (*approximately 2.6 GB compressed)

Look for any brand of:

· 90 meter DDS/MRS tape: holds up to 2 GB (*approximately 4 GB compressed)

· 60 meter DDS/MRS tape: holds up to 1.3 GB (*approximately 2.6 GB compressed)

*Compression capacity will vary; average is 2:1.




